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SUPPORT SERVICES 

Relate Software is committed to strong customer service and satisfaction. At all times you will be able to make contact with our 
company and our technical service teams. Relate Software will provide the highest level of customer service and will provide 
telephone support as well as online remote access support and where applicable we will call out onsite to help resolve any support 
issue. 
 
You can make contact with our support department in the following ways: 
 
Telephone: 
 
Ireland: +353 (0)1 4597800 
United Kingdom: +44 (0) 871 284 3446 
 
Fax: +353 (0)1 4597779 
 
Email: support@relate-software.com 
 
Opening Times for Support 09:00-13:00, 14:00-17.30 
 
We also provide out of hours support via mobile phone. If you find that you need out of hours support simply call the support 
department and they will provide you with a mobile number where support will be available at an agreed time.
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COPYRIGHT 

This document and software described in it are copyrighted with all rights reserved. Under copyright laws, neither the documentation 
nor the software may be copied, photocopied, reproduced, translated or reduced to any electronic medium or machine readable form, 
in whole or in part, without prior written consent of Relate Software (’Relate’). Failure to comply with this condition may result in 
prosecution.  
 
This computer program is the property of Relate. The program is protected under copyright law and is licensed strictly in accordance 
with the conditions specified in the Software Licence. Sale, lease, hire, rental or reassignment to, or by, a third party without the prior 
and written permission of Relate is expressly prohibited.  
 
Relate does not warrant that the software package will function properly in every hardware / software environment. For example, the 
software may not work in combination with modified versions of the operating system, with certain print-spooling or file facility 
programs, or with certain printers supplied by independent manufacturers.  
 
Although Relate has tested the software and reviewed the documentation, Relate makes no warranty or representation, either 
express or implied, with respect to this software or documentation, his or her quality, performance, merchantability, or fitness for a 
particular purpose. This software and documentation are licensed ‘as is’, and you, the licensee, by making use thereof, are assuming  
the entire risk as to their quality and performance.  
 
In no event will Relate be liable for direct, indirect, special, incidental, or consequential damages arising out of the use or inability to 
use the software or documentation, even if advised of the possibility of such damages.  
 
Disclaimer: Relate’s policy is one of constant development and improvement. We reserve the right to alter, modify, correct and 
upgrade our software programs and publications without notice and without incurring liability.  
 
Copyright:   2009 Relate Software  
                   Unit D6, South City Business Park, 
                   Whitestown Way, Tallaght, Dublin 24 
 
Issue Date: 12/01/2009                    All Worldwide Rights Reserved  
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INSTALLATION 

How to install the software for the first time is explained in this chapter. It covers a Standalone (single user) installation and Network 

(multi-user) installations. 

 

This chapter will outline how to install Relate Corporation Tax Manager on to one computer or a network for the first time. The 

following topics will be covered in detail: 

  

 Standalone/Network System Requirements 

 Standalone/Network Installation 

 Starting Relate Corporation Tax Manager  

 Product Registration 

 Support Services 
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Standalone/Network System Requirements   
 
When installing Relate Corporation Tax Manager for the first time please take note of the following and recommended system 
requirements. 
 

Standalone System Requirements 
 
The minimum requirement for a computer to run the Relate Corporation Tax Manager is a P4 processor or better. The computer will 

need 512MB of memory (Vista/Windows 7 – 1GB) and at least 50Mbytes of free space on the hard disk. An SVGA monitor which 
should support a screen resolution of at least 1024 x 768 pixels.   
 
The computer will need to run on one of the following operating systems: 
 

 Microsoft Windows XP 

 Microsoft Windows Vista 

 Microsoft Windows 7 
 

 

The recommended requirement for a computer to run the Relate Corporation Tax Manager is a processor of 200MHz or above. The 

computer will need 1GB of memory (Vista/Windows 7– 2GB). An SVGA monitor which should support a screen resolution of at least 
1024 x 768 pixels.   
 
The computer will need to run on one of the following operating systems: 
 

 Microsoft Windows XP 

 Microsoft Windows Vista 

 Microsoft Windows 7 
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Network System Requirements 
 
The minimum requirement for a SERVER to run the Corporation Tax Manager is a P4 processor or better (or compatible 

equivalent). The computer will need 1GB of memory and at least 50Mbytes of free space on the hard disk. 
 

The minimum requirement for a WORKSTATION running the Corporation Tax Manager is P4 processor or better (or compatible 

equivalent). The computer will need 512 (Vista/Windows 7 – 1GB) of memory and at least 50Mbytes of free space on the hard disk. 
An SVGA monitor which should support a screen resolution of at least 1024 x 768 pixels.   
 
The computer will need to run on one of the following operating systems: 
 

 Microsoft Windows XP 

 Microsoft Windows Vista 

 Microsoft Windows 7 
 

Relate Corporation Tax Manager will run on a Peer-to-Peer network but we do not recommend the use of this kind of network.  
 

The recommended requirement for a SERVER running the Corporation Tax Manager is a P4 processor or better (or compatible 

equivalent). The computer will need 4GB of memory and at least 200Mbytes of free space on the hard disk 
 

The recommended requirement for a workstation running the Corporation Tax Manager is a P4 processor or better (or compatible 

equivalent). The computer will need 1GB (Vista/Windows 7 – 2GB) of memory and at least 200Mbytes of free space on the hard disk. 
An SVGA monitor which should support a screen resolution of 1024 x 768 pixels.   
 
The computer will need to run on one of the following operating systems: 
 

 Microsoft Windows XP 

 Microsoft Windows Vista 

 Microsoft Windows 7 
 

 



Success Built on Service   9 

SELECTING THE RIGHT INSTALLATION OPTION 

The installation CD allows you to install Relate Corporation  Tax in a number of different ways. It is very important that you read the 

instructions completely in order to understand which option is the right one to take. 
Effectively there are three options: 

1. Install the program and the database 

2. Install the program only 

3. Install the database only 

Installing the Program and the Blank Database 

 
This option is used in the following situations: 
Server Installation: New installation. You are installing on a server, and there is no existing DRIVE or Relate Corporation Tax 

database already on that server. If there is no previous Relate product installed then there is no central database available. The 
central DRIVE database must be available to operate the software.  
 
Standalone Installation: New Installation. You do not have a server but have a standalone pc. This will install the software and 

database as if the pc was a server  
 
Portable Installation: You are installing on a portable computer on which you want to use Relate Corporation Tax outside of the 

office. This means that the portable has to have its own local database available.   
 
Install the Program only 

This option is used in the following situations: 

1. Local Installation: You are installing on a pc attached to the network server which has the database already installed.  This 

pc is not used outside of the office therefore the database is not needed. 

This is the most widely used option on a network. 
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Install the Database only 

This option is used in the following situations: 

1. Local Installation: The program is already installed on this pc and you now want to use Relate Corporation Tax outside of 

the office. This pc will need to have the database installed.  

This option will not be used that often. 

 

2. Local Installation: You have a separate Database Server where you want to place the database without the program.  In this 

case you should use the Advanced options to untick the SQL Express database engine install as it is not needed. 

This option will not be used that often. 
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Installing the Program and Blank Database 
The installation wizard makes the process of installing Relate Corporation Tax an easy and straightforward exercise. 

1. Place the program CD into the CD-ROM drive. If you have auto run enabled on your CD-ROM drive, the installation wizard 

will automatically appear. If it does, skip to step 4. 

2. From your Windows Desktop, click on the Start Button and the start menu will appear. From the Start Menu choose Run. 

The Run window appears as follows: 

 
Figure 1 

3. When you press OK the standard Relate Corporation  Tax installation wizard will appear 
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4. The installation wizard begins and the setup program will display the first screen. Select Program and Blank Database 

install, as follows: 

 
Figure 2 
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5. Press Next, and you will be prompted for the database name and location for the database files as follows: 

 
Figure 3 

6. Type a suitable database name where prompted.  This name should begin with “Drive” and should only contain letters, 

numbers or “_” characters.  This database will be created in a new SQL Server instance, named as follows:  

{your server’s name}\Relate. 

7. Select a suitable location for the SQL Server database files.  Note that depending on usage these files may grow to several 

gigabytes, so select a drive which is adequately large. 
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8. Click “Finish”, and installation will be completed for the following items.  If you do not wish to install some of these items, 

please select “Advanced” and unselect them before clicking Finish. 

a. Windows Installer 

b. Relate Corporation  Tax Setup 

c. Latest version of Relate Corporation  Tax 

d. Dot NET Framework 2.0 

e. SQL Server 2005 Express 

f. SQL Server Management Studio 

g. Restore Blank Database 
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9. Relate Corporation Tax is now installed on your server.  Click the  icon on your desktop to run it.  You will be presented 

with a request for connection details as below: 

 
Figure 4 

10. Enter the Server name as {your server’s name}\Relate. 

11. Enter the database name as you entered during the installation process. 

12. When you click OK, you will be prompted to update the database and then brought to the Corporation Tax registration 

screen.  Please phone +353 (1) 4597800 to get your registration details. 
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13. Congratulations, you are now ready to begin using Relate Corporation Tax. 
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Installing the Program Only 
The installation wizard makes the process of installing Relate Corporation  Tax an easy and straightforward exercise. 

1. Place the program CD into the CD-ROM drive. If you have auto run enabled on your CD-ROM drive, the installation wizard 

will automatically appear. If it does, skip to step 4. 

2. From your Windows Desktop, click on the Start Button and the start menu will appear. From the Start Menu choose Run. 

The Run window appears as follows: 

 
Figure 5 

3. When you press OK the standard Relate Corporation  Tax installation wizard will appear 



Success Built on Service   18 

 

4. The installation wizard begins and the setup program will display the first screen. Select Program install, as follows: 

 
Figure 6 
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5. Press Next, and then press Finish 

 
Figure 7 

6. Click “Finish”, and installation will be completed for the following items.  If you do not wish to install some of these items, 

please select “Advanced” and unselect them before clicking Finish. 

a. Windows Installer 

b. Dot NET Framework 2.0 

c. Relate Corporation  Tax Setup 

d. Latest version of Relate Corporation  Tax 
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7. Relate Corporation Tax is now installed on your computer.  Click the  icon on your desktop to run it.  You will be 

presented with a request for connection details as below: 

 
Figure 8 

8. Enter your server and database name.  If you are uncertain of these, you can get them from your Network Administrator. 

9. When you click OK, you are now ready to begin using Relate Corporation  Tax. 
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Installing the Blank Database Only 
The installation wizard makes the process of installing Relate Corporation  Tax an easy and straightforward exercise. 

1. Place the program CD into the CD-ROM drive. If you have auto run enabled on your CD-ROM drive, the installation wizard 

will automatically appear. If it does, skip to step 4. 

2. From your Windows Desktop, click on the Start Button and the start menu will appear. From the Start Menu choose Run. 

The Run window appears as follows: 

 
Figure 9 

3. When you press OK the standard Relate Corporation  Tax installation wizard will appear 
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4. The installation wizard begins and the setup program will display the first screen. Select Blank Database install, as follows: 

 
Figure 10 
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5. Press Next, and you will be prompted for the database name and location for the database files as follows: 

 
Figure 11 

6. Type a suitable database name where prompted.  This name should begin with “Drive” and should only contain letters, 

numbers or “_” characters.  This database will be created in a new SQL Server instance, named as follows:  

{your server’s name}\Relate. 

7. Select a suitable location for the SQL Server database files.  Note that depending on usage these files may grow to several 

gigabytes, so select a drive which is adequately large. 
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8. Click “Finish”, and installation will be completed for the following items.  If you do not wish to install some of these items, 

please select “Advanced” and unselect them before clicking Finish. 

a. Windows Installer 

b. Dot NET Framework 2.0 

c. SQL Server 2005 Express 

d. SQL Server Management Studio 

e. Restore Blank Database 

9. Your new database is now installed and ready for use.  When you first connect to it in Relate Corporation  Tax, you will be 

brought to the RAP Registration screen.  Please phone +353 (1) 4597800 to get your registration details. 



Success Built on Service   25 

 

GETTING STARTED 

1. Once the package is installed the following icon will appear on the desktop  click the icon to start the program. 

 

2. When you launch the program for the first time, you will need to enter the Sever details as well as your Database Name.  
 

 

Figure 1 
 

3. If you are a DRIVE CRM user you can get these details from DRIVE by clicking on Tools> Change Database. Take the 
details and enter them into the screen above.  

4. If this is a new installation and a new database the default login User ID. Is SYSADM and no password. 

5. Click on the desktop icon again and the system will load the Registration screen.  A Relate Software technician may 
have already registered the product for you and if so move onto the next section. If the system is not registered follow 
the instructions below. 
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Product Registration 
When you access the program for the first time the system will recognize that the program has not been registered. The 

 system will not run unless it is registered. 
 

1. To register your product call the Relate Software Hotline at 
the following number: 

Ireland       +353 (0)1 4597800 
 UK  +44 871 284 3446 

 

2. The registration screen will appear as in Figure 8: 
 

3. In order to register the software you must speak to a Relate 
Support staff member who will take you through the 
registration procedure. 

 
4. The support person will ask you to call out the Serial 

Number that will be displayed automatically when you 
install the system. 

 
5. Complete the licence screen based upon the licence you 

have purchased along with the licence renewal date. 
 
6. The support person will now call out an Activation Key based on the information provided. 
 
7. Enter the Activation Key and click the Register button. The system has now been registered. 
 
8. You should retain a copy of your Activation Key and the best way to do this is by clicking the Print Screen button on 

your keyboard, which will print a copy for you. 
 
9. The system is now registered and ready for use. 
 

When the Licence Renewal Date is reached, you will need to renew your licence. This will usually be a year from the date of 
registration. One month in advance of the renewal date the system will give a warning to call the support hotline in order to 
get a new registration key. One month’s warning will be given. 

 

Figure 2 
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CONCEPT BEHIND RELATE CORPORATION TAX MANAGER 

Relate Corporation Tax Manager has been developed to help firms manage and maintain their client corporation tax information. The 
package is linked to DRIVE, the most widely used Accountants CRM package on the market. The Corporation tax client information 
is shared between the two packages. All companies from DRIVE will appear in the corporation tax package. If you do not do 
corporation tax returns for some of these clients you can hide them. 
 
The system highlights through the tax return summary dashboard all clients with outstanding returns, returns not created as well as 
the status of their returns such as sent to client for signing or submitted to ROS. 
 
The system allows you to Import last year’s ROS CT1 file into the tax database. This will read the tax information on your client and 
automatically load it as a client into Relate Corporation Tax Manager. This saves a lot of time and it also allows you to roll over the 
client’s tax return information so that you can easily do the new tax return. 
 
The package allows for updating of clients corporation tax information into a central database. Once updated the user can click the 
calculate button and the system will automatically send an xml file to the Revenue online calculation engine. Within seconds the 
system will return the CT1 Calculation report.  
 
If you are happy with the tax return, simply click the submit button and the system will create the CT1 file for submission. The 
package will automatically bring you to the upload section of ROS so that you can upload the file. Relate Corporation Tax Manager 
will soon have the function to automatically upload the file directly to the ROS engine with notification number and status being 
returned to the package itself. 
 
The Datamining routine allows a firm to send information requests of impending tax returns to clients by using the mail merge 
function. It also allows you to run a series of data queries to get information from the tax database for example: produce a list of all 
tax clients who have rental income or list all clients who took advantage of film relief last year. 
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HOW TO NAVIGATE CORPORATION TAX 

Navigation bar: you can drag shortcuts to different positions on the navigation bar to suit the order of your work. The tax package 
does not have many shortcuts so the standard layout probably does not need adjusting. 
 
Use the text drop down menu to select the options you want to execute. 
 
Use the tool bar (new, open, print, delete and find plus screen-specific icons) by clicking on the option. 
 
The right click option on most browse screens will allow you to add, edit and delete records.  On the clients & tax returns screen view 
the status of a client’s tax return can be changed by right clicking. You can also perform a tax year rollover from this menu. 
 
Columns can be sorted (where relevant) by clicking column headers, you can filter (where relevant) columns as well as change 
column widths. Additional columns can also be selected using the Column Chooser option. 
 
Double click will generally bring you into a drill down facility where appropriate. 
 
Click on hyperlinks (to add new database items on the fly or to expand the information). Blue or blue underlined text indicates a 
hyperlink to a smaller database or lookup. 
 
Use the Find option: clicking a second time turns it off. 
 
Use Fast Search (on long browse screens). 
 
Pressing F1 will generally call up online Help if it is available. 
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HELP  

The help menu contains a couple of important options to help you when you contact our support department. The first one is the 
Relate Software Remote Support. This option allows a Relate support consultant to remotely logon to your pc and look directly at 
your screen so that you can better explain the issue you are having. When you click the option below, the system will automatically 
launch Internet Explorer and bring you to the login site. The support person will give you a secure code and you can follow their 
instructions. 

 

 
Figure 3 

 
 
 
 
The fifth option is About, click on about to find out what version of the software you currently have installed. 
 

 
Figure 4 

 
Version 1.0 Build 21 for example is what you tell the support person should they ask. 

Remote 
Support 
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MAIN PROGRAM WINDOW 

Relate Corporation Tax manager opens on the client and Tax Returns screen. This acts as the main menu for the system.  

 

Figure 5 

 
On a new installation the list of clients will be blank. If you are a DRIVE or RAP User, the DRIVE/RAP client list will automatically 
appear. Only Individuals and sole traders will appear but you can add a tax return to each of the clients listed from DRIVE/RAP. You 
can add new clients, other than DRIVE/RAP clients to Corporation Tax by clicking on the new button. 
 
The Return Summary dashboard allows you to keep track of returns for the current tax year. 
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USER ACCESS GROUP 

When you enter the system for the first time, you will have to use the default System Administrator’s access rights and password. 
Once Access Groups have been defined, they can be applied to individual staff. Using the access rights, you can restrict routines. 
You can password individual client returns by applying a password. 

 
Defining User Access Groups  
From the Tools menu, choose the User Access Groups option. The Access Groups window appears listing all of the available groups. 
Click Add. The Access Group window appears.  
 
 

    
    Figure 6         Figure 7 

 
 
 
 
 
To apply an access group to a staff member go to the staff section and edit the staff members details and apply. 

Enter a Name for the Group and then tick the 
options you want available to the group you are 
creating 
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ADD A CLIENT AND TAX YEAR 

New clients can be added through the normal add button from the clients and tax return browse but you can also use the Ros Import 
button which will automatically load your client information from their last years .CT1 ROS xml file. This can save considerable time 
and effort as it will upload all the relevant information. Please note that this will upload the information into the year that the .CT1 file 
relates and you will then need to do a rollover. See below for details. 
 

To add new a client tax year, click New   from the toolbar. New Client and Tax Year window appears as follows: 
 

 
Figure 8 

 
Add the following details:  
 
Entity Type: This can only be either individual or sole trader; all other entity types are not applicable.  
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Client Code: Client codes can be manual or automatically created. In case of automatic coding, each code may be broken up into 

several segments. The client code can be based on up to six criteria, i.e. client name, office, partner, department, manager and a 
unique number generated by the system. For further details, refer to the Settings section.  
 
Name: Enter the name of the client. Clicking the lookup displays an additional screen to add details on the individual such as Gender, 

Title, Forename and Surname, salutations (both formal and informal). 
 
Partner: Select the name of the partner in charge of this client from the drop-down list. Alternatively, click the Partner link to display 

the Select Partner window. Select a partner from the list. 
 
Manager: Select the name of the manager from the drop-down list. Alternatively, click the Manager    link to display the Select 

Manager window. Select a manager from the list. 
 
Lead Staff: Select the lead staff from the drop-down list. Alternatively, click the Lead Staff link to display the Select Staff window. 

Select the lead staff from the list.  
 
Business Type:  Select business type from the drop-down list. Alternatively, click the Business Type lookup to display the Business 

Type window.  
 
Password: Enter the password for the client. System will ask for the Password if you try to edit the client. 

 
Confirm Password: Enter the Password again to confirm and save it in the database. 

 
Tax Year: Select the Tax Year from the drop down list. Initially this will be 2007 or 2008 but each year will be added in annual 

updates 
 
Tax Client: This will automatically be set to on the add screen but can be taken off on the edit. Tax Clients will be displayed in the 

Client and Tax Returns Browse with this icon beside them . 
 
To save the client details, Click OK. 
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Add a New Tax Year 
For existing clients, you can add a New Tax Year from the Client and Tax Returns browse. Add Tax Return window appears.  
 

 
Figure 9 

 
It will display the Entity Type, Client Code and Business name. You can enter Password and Confirm Password to restrict access of 
the client. Select Tax Year from the drop down menu. Click ok to save the details. A new Tax year will be generated for the client.  
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ROS Import 
The ROS Import option allows you to find and select a clients ROS .CT1 file and import their information into the Relate Corporation 
Tax database.  The first thing to do is to setup your default Path For CT1 Files. To set this up goto Tools >Settings and then select 
the Tax Details Tab. 
 
Half way down the screen, enter the Path for CT1 Files. 
 

 
Figure 10 
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Once this has been setup click File > ROS Import from the main menu or click the ROS Import button from the Clients and Tax 
Return browse. 
 
The following screen will appear:  
 

 
Figure 11 

 
The system will list all of the .CT1 files in the specified folder and its sub-folders. If you have other directories and not 
one master directory you can click on the “Search for CT1 files” button and select the XML folder path. The list of all xml 
files automatically appears in the window with imported flag set to ‘No’.  Select the file you want to import.  
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Click ROS Import button. Select a Client window appears. 
 

 
Figure 12 

 
This should default to the appropriate client if the PPS number agrees. If they do not you will need to select the client which the .CT1 
file relates to/ Select a client code from the drop down menu. The xml file will be imported into this client. Once you select the client 
code, the PPS number and address will be displayed. Once the xml file has been completely imported the imported status will be set 

to ‘Yes’.  Id no Client is selected you will be prompted to enter in some basic client information. 
 
Use the ROS Import & Rollover button, to import the XML files and perform a tax year Rollover. This will do exactly the same as the 

ROS Import button but it will also create a new blank tax year for the clients next tax year. It is a timesaver. 
 
Use find tool to search for a client’s return.  
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Use Refresh tool to refresh the list of xml files in the import window based upon the path selected. 

 

Rollover 
Click the Rollover button on the clients and tax return browse to create a new tax year. When you click the button on an existing tax 
year the following message will appear. You can thenroll over for just the selected tax return or for all current year tax returns to the 
new year. 
 

 
Figure 13 

 
 

Once the procedure ends, a new tax year will have been generated. 
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CT Return Diary 
This facility will automatically populate with returns that are due for the coming month. The diary will display the client name, the 
number of days left to the filing date and the current status of the return. 
If the filing date or due date has passed the return will be highlighted in red, to indicate the return is late. Returns which are not 
marked as “Submitted or Assessment Received” will be deemed as outstanding and will continue to show on the diary. To remove 
returns which are no longer outstanding you must change the status to be “Submitted” or “Assessment Received”. 
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The diary screen also contains the following buttons: 
PREVIOUS: Gives you the ability to go back to previous months to view returns from that month. 

 
NEXT: Enables you to move forward in months to see what returns are due in the selected month. 

 
PREVIEW: This will present the diary in a report format which can also be printed. 

 
At the bottom of the diary screen there are two totals: 
 
RETURNS OUTSTANDING This is the total number of returns that are still not complete and considered to be at ongoing. This will 

include both returns that are late and returns that are ongoing and have a upcoming filing date. 
 
LATE RETURNS: Is an accumulative total of all returns where the return date has passed. 

 
USER: The user option acts like a filter of returns that appear on the diary. It allows you to only see returns which belong to a specific 

user. In order for this to work correctly each client must have a staff member assigned to them on the client screen. However this is 
not mandatory and if a staff member is not selected the diary will display all returns due for the selected month. 
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The diary will appear automatically when the package is opened, this is the default setting for this feature. However it is possible to 
turn this off within the settings screen as seen below. Simply un-tick the “Display Diary Option” 
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You can view the CT diary at any point and not just when you log into the program by pressing the new “Return Diary” button located 
on your main client listing screen toolbar as seen below. 
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Status 

To view the Status on a Client Tax return, Click on the Status tool from Toolbar . Client and Corporation Tax Year Status 
window appears as follows. 

 
Figure 14 

 
The Tax Return Status screen shows the workflow Tasks as listed on the left side of the screen. Tasks can be marked Completed 
only if the previous Tasks are also marked as Completed. The different status types available are ‘Not Started’, ‘In Progress’ or 
‘Completed’. The Staff member responsible for the Task and the Completed date may be selected. A Note may also be entered. The 
Staff name will automatically default to the user logged in but this may be changed by clicking on the down arrow. Similarly the date 
will default to today’s date.  
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Backup/Restore 
The backup routine allows the user to backup a single client tax return to a local pc or memory key. This allows you to take details of 
a client’s tax return home to work on. The Backup screen will appear as follows: 
 
 

 
Figure 15 

 
 

Click Backup and a message will appear “Backup Completed”. If you go to explorer you will see a series of backup files with the 
extension .ctax. 
 
Restore will perform the reverse routine and update the database with the new information. 
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Check-Out/Check-In 
The check-out routine works in the same as the backup routine but the difference is that the clients tax return is now locked on the 
system so that nobody can change the details until the return is checked back in. The Checkout screen will appear as follows: 
 
 

 
Figure 16 

 
 

Click the Check-Out button a message will appear “Check-Out Completed”. If you go to explorer you will see a series of checked-out 
files with the extension .ctax. 
 
The Checked-Out column on the client and tax return screen will have the word “Yes” filled in. The tax return will also change colour 
from black to red to indicate is has been checked-out. 
 
Check-In will perform the reverse routine and update the database with the new information. 
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Payment 

Select the   button from the toolbar. The payment window opens.  
 
 

 

Figure 17 
 
It displays each of the tax years entered for this client and holds the following information, Previous Year Liability, Preliminary Tax 
Paid, Current Tax Liability, Balance Due, Capital Gains,CGT1 liability ,CGT1 Paid,CGT1 Balance,CG2 Liability, CGT 2 Balance. 
Enter the amount you have paid as Preliminary Tax, Balance Due will be the difference of Current Tax Liability and Preliminary Tax 
Paid.  
 

Expand All/Collapse All 
As the number of returns on the system hit hundreds of returns it is often helpful to collapse the main client and tax return list. This 
effectively displays just the client list with the clients most current year displayed. Expand will reverse this and show all  clients and all 
tax returns. 
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Return Summary Dashboard 
The Return Summary screen is updated as you process information. It will tell you how many returns have not been created yet, how 
many are incomplete. The middle Return Status panel will quickly show you how many of your current year tax returns are at different 
stages of completion. 
 

 
Figure 18 

Click this bar to show or hide summary details 
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Search 
The Fastsearch feature is activated as soon as you begin to type part of the client name while in the clients and tax return browse. If 
you cannot find the client using the Fastsearch feature click on the magnifying glass button and you can search the full list using all 
fields. 

  
Figure 19 

 
There is also a filter option on the search screen which allows you to further reduce your search criteria. 

Begin Typing on browse to use Fastsearch function 
 

Search for a client using the Find 
feature 
 



Success Built on Service   49 

 

CORPORATION TAX RETURN CT1 

The tax return schedules are made up of the following sections: 
 
Company Details 
Trading Results 
Irish Rental Income 
Irish Investment and Other Income 
Foreign Income 
Exempt Profits 
Capital Gains 
Chargeable Assets 
Deductions, Reliefs and Credits 
Capital Gains (Development Land) 
Close Company Surcharge 
Recovery of Income Tax 
Dividend Withholding Tax 
Request for short notice 
Property Based Incentive 
 
Each section will have a number of subsections, each of which contains information which must be completed depending upon the 
complexity of the client’s tax return. 
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Corporation Details 
When you add a new tax year or double click onto an existing tax year the following screen will appear: 
 

 
Figure 20 

 
The layout and content of the above pages are very familiar to users of the Revenue Offline application. These have been developed 
with users of this application in mind. It allows for an easy transition. Simply go through each page by using the Back and Next 
buttons. If you have converted the data over from an .CT1 file the information will just need to be edited to complete the return. 
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The following screen shows an example of where sections have been filled in. 
 

 
Figure 21 

 
The above screen is highlighting all of the tax return areas that have been filled in for NightClub Ltd. The system has a series of alerts 
and messages as well as validation errors where information has not been entered properly or completely. 
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Click on Company Details and the following screen will open. Complete the information requested. 
 

 
Figure 22 

Name of Company 

Enter the name of the client. For example, Nightclub Limited 
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Tax Reference No  

This is mandatory information for filling the Tax Form. This is an eight digit unique number in which the first 7 numbers are digits and 
the last one is an alphabet. 
 
Trading State Tick Box 

If the company is trading in the country through a trading branch or agency it must be declared by ticking this box. 
 
Cessation Date 

If the company has ceased trading during this tax year then the date can be specified by using the date selection option on this 
screen. 
 
 
Note: Continue to complete all the information you deem necessary to complete the Corporation Details section for your client. You 

can click the Next button to go onto the next sub section. If you click Home it will bring you back to the start of the section you are on. 
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Trading Results 
This section provides details of any income or expenditure from  the company’s trading for the year . From the Tree view, select 
Trading results. The Trading Results section opens.  
 

 
Figure 23 

Use the Next Button from the toolbar to navigate your way through the subsections and fill in the various applicable sections.
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The only additional information which can come from outside the database is the “Extracts from Accounts” 
 

 
Figure 24 

 
Note: Continue to complete all the information you deem necessary to complete this section for your client. You can click the Next 

button to go onto the next sub section. If you click Home it will bring you back to the start of the section you are on. 

Extracts from Accounts will automatically pull 
accounts figures in from Relate Accounts Production 
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Extracts from Accounts 
 
When the “Extracts from Accounts” Button is pressed the Relate Corporation Tax extracts specific Nominal Reporting Group Values 
directly from the set of accounts in Relate Accounts production. Below is a list of the nominal reporting groups broken down by 
section. The “Adjustments” section on page three refers to the “Disallowed for Tax” total on the groups as opposed to the year end 
figure. 
 

Corporation Tax Item RAP Nominal Group 

Income  

Sales/Receipts/Turnover TurnTax - GovGrants 
Receipts from Government Agencies GovGrants 
Other Income including tax exempt income OthIncProf 
  
Trading Account Items  
Purchases CostSalesTax + DirCostsTax 
Gross Trading Profits Total of Groups above 
  
Expenses and Deductions  
Salaries/Wages, Staff Costs EmpeeCost 
Sub-Contractors SubConCost 
Consultancy, Professional Fees LegProf 
Motor, Travel and Subsistence MotExpTax + TravSubsist 
Repairs/Renewals Repairs 
Depreciation/Goodwill capital write-off DepnPrLsAdmin 

Provisions including bad debts – positive BadDebts 
If negative state amount here  
Other Expenses (Total) OthExp + PremCosts + GenAdmin + AdvPromEnt + InterestTax + OthFinChg 

 
Note: The corporation tax package will extract the figures from the set of accounts in Relate Accounts Production once the code of 

the client is the same in both packages. 
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Irish Investment and Other Income 
 

 

 
       Figure 33 
 
By selecting this section from the tree view you will be presented with this screen with the sections to complete as follows. 
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Interest Arising In The State 

There are two fields in this section that can be filled in accordingly. 

 Gross Interest received or credited under deduction of Irish tax. 

 Gross Interest received or credited without deduction of Irish tax. 
 

 
Other Irish Income 

There are a number of fields that can be filled in here if applicable to your client ,however there is also a sub section dri lldown 
available in this section. 
 

 
      Figure 34 
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By clicking on the blue hyper link “Investment Undertakings” the following screen will appear. 
 

 
      Figure 35 
 
There are 3 options on this screen Add, Edit and Delete. These relate to the details in the grid below them on screen. 
 
 
 
 
 
 
 



Success Built on Service   60 

Pressing the Add button will make additional fields relating to the investment details. As can be seen on the screen below. 

 
      Figure 36 
 
Once these details have been entered, pressing the “Add” button again will submit them to the grid. 
 
 
 
 
 
 
 
 

Pressing the Add Button 
will make the hidden 
fields  appear 
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The below screen shows details within the grid once they have been added. 

 
 
       Figure 37 
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Edit Button 

To edit details that have already been entered an submitted to the grid on this screen, pressing the edit button will allow you to 
change these details. Once changes have been made ,pressing the add button will submit these changes back to the grid again. 
 
 
Delete Button 

To remove an entry from the investments grid, highlight the entry by clicking on it with a left mouse click and then press the delete 
button. This will remove the selected entry from the grid. 
 
 
 
Note: Continue to complete all the information you deem necessary to complete this section for your client. You can click the Next 

button to go onto the next sub section. If you click Home it will bring you back to the start of the section you are on. 
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Foreign Income 
This section contains 5 sub sections 4 of which contain grids that details can be entered like previously mentioned in the Irish 
Investment and Other income section. 
 

 

Figure 38 
 The first section is “Foreign Income excluding Foreign Life Policies & off shore funds “this subsection, simply contains 3 fields where 
the data can be entered and one total field that will automatically update based on the 3 numeric fields above it. There is no 
drilldowns or data entry grids in this sub section. 
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Exempt Profits 
There are subsections within this main section. Stallion fees, Woodland fees and Greyhound Stud fees. 

 
Figure 39 
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All 3 sections within the Exempt Profits section are similar to each other and contain  3 data entry boxes and no subsections or 
drilldowns. 
 
Note: Continue to complete all the information you deem necessary to complete this section for your client. You can click the Next 

button to go onto the next sub section. If you click Home it will bring you back to the start of the section you are on. 
 
 

Capital Gains 
This section outlines any Asset Disposals that your client has undertaken from Shares, Land & Property to Foreign Life Policies. 
 

 
Figure 40 
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Note: Continue to complete all the information you deem necessary to complete this section for your client. You can click the Next 

button to go onto the next sub section. If you click Home it will bring you back to the start of the section you are on. 
 
 

Chargeable Assets 
This section covers any assets acquired during the tax period. Simply fill in the information in each section 
 

 
       Figure 41 
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Deductions Reliefs and Credits 
This section allows you to fill in details regarding any reliefs or credits due in this tax period. 
 

 
 
                     Figure 42 
 
 
 
Note: Continue to complete all the information you deem necessary to complete this section for your client. You can click the Next 

button to go onto the next sub section. If you click Home it will bring you back to the start of the section you are on. 
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Capital Gains Development Land 
This section contains details of any assets disposed of or acquired regarding development land  

 
       Figure 43 
 

 
 
 

 
Note: Continue to complete all the information you deem necessary to complete this section for your client. You can click the Next 

button to go onto the next sub section. If you click Home it will bring you back to the start of the section you are on. 
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Close Company Surcharge 
There is only one screen in this section relating to close companies. This section will apply to most Irish Resident Companies. 
 

 
       Figure 44 
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Recovery of Income Tax 
There is a single screen for this section. Simply fill in the applicable details and use the desktop tree view to navigate to the next 
section. 
 

 
       Figure 45 
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Dividend Withholding Tax 
There is a hyperlink on the main screen of this section which when clicked in is a drilldown to enter “Details of a Distrubution made by 
the company” which can be seen on the screen below. 
 

 
       Figure 46 
 
Once the hyper link is clicked it will produce the following screen allowing you to enter details of the distributions made. 
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Figure 47 

Like in previous sections pressing the add button will allow you to enter the details of the Distribution. Once the details have been 
entered pressing the Add button again will save the details you have entered. 
 
 
Note: Pressing the Back button will bring you back to the main Dividend withholding tax screen. 
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Request for short notice 
This section contains only a single tick box where you request a Short Notice of Tax Assessment. This is a shorter form and does not 
give a breakdown of allowances etc.  
 
 

Property Based Incentive 
This section covers investments in property with specialist interests such as Park & Ride, Seaside Resort and Urban Renewal 

 

Figure 48 
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CALCULATION & SUBMISSION 

Once you have completed inputting the tax return information and you are happy that you have completed each of the sections and 
subsections, simply click on the Calculate button on the tax return screen. 
 

  
Figure 49 

 
When you click the calculate button Relate Corporation Tax Manager will automatically go onto the internet and go to the Revenues 
Tax Calculation Engine and return a CT1 Calculation Report. The report is based upon figures returned from Revenue. 
 
The calculation uses the ROS web services to do a draft calculation, they are simply returned to the package so that the user can see 
what the clients potential tax liability and return will be like. 

Calculate using ROS Web Services 
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Calculation Report 
The calculation report created looks like the following:  
 

 
Figure 25 

 
As per the screen above the layout has been formulated to be in line with the Revenue Offline Application but has been improved to 
ensure that the layout stays on as few pages as necessary and that the fonts have been consistently applied. 
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Validation Error Report 
The validation error report is created when something ahs been entered which cannot be returned to the ROS calculation engine. 
Self validations help to ensure that returns adhere to the Revenues systems. The validation error report will appear as follows:  
 

 

Figure 26 
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CT1 
Once you are happy with the CT1 calculation report you can decide to print the full CT1 form by clicking on the CT1 button on the tax 
return screen. 
 

 
Figure 27 

 

 CT Return 
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The CT1 Form will look like the following screen and will run to a few pages outlining every section that has been completed as well 
as sections that are not applicable.  
 

 
Figure 28 

 
The last page has the signing section and declaration which your client needs to sign. There is an option to create an export file to 
PDF for sending to your client for signing. 

Create PDF CT1 for 
emailing to your client 
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Submission  
Once you are happy that the client has accepted the tax return and the tax liability, it is time to submit the return. Click the Submit 
button on the tax return screen. 
 

 
Figure 29 

 

 
Figure 30 

 
The current version of Relate Corporation Tax Manager will bring up the following message: 

Create 
CT1 
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The message explains that the software has generated a CT1 xml file in the default ROS CT1 directory. When you click OK the 
system will automatically launch the ROS login screen as follows: 
 

 
Figure 31 

 
 
Login as you normally would and upload the return. Relate are working on a direct submission routine from the package itself which 
will cut this cumbersome part of the process out. This upgrade will be made available to all users as part of their normal licence 
agreement. At this point you should update the status of you return to submitted. 
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DATA MINING 

Data mining is a tool used to interrogate the tax database of client information to help manage the tax return process. It is also used 
to target, sell and market the firm’s tax services. The data mining routine will give the user the ability to do complicated search and 
retrieve operations on the client database i.e. create a list of all clients who have a tax liability in excess of €100,000  
The user can create as many data queries as they like. To create a datamine click on Data Mining on the navigation bar.  
 

 
Figure 32 
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Then click New. The Query window appears showing the Details tab.  
 

 
Figure 33 

 
In the Details tab page, you have to specify the kind of query that you want to generate.  
 
Enter the following information:  
Description of Query  
Query Group - Select the group of the query from the drop-down list. If the group you are looking for is not a part of the list, then you 
can enter the name of the query group here. It will be added to the list, for you to use the next time.  
Source of Information  
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Click on the Query Builder Tab. The Query Builder window appears showing the following:  
 

 
Figure 34 

 
The Query Builder helps you define the information you are looking to retrieve from the database. The query statement appears at 
the bottom of the screen. 
 
Select the section or field name that you are looking for, from the Field drop-down list. Then select the condition that you want to 
specify from the Condition drop-down list. Once that has been done, enter the value that you are looking for in the Value box. Select 
either “and” or “or” depending on whether you want all the conditions that you have specified, to be met or any one.  
 
Multiple lines can be entered here for detailed queries. 
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Click on the Fields Tab to select or unselect the fields of information you want to appear on your datamine. These fields will be 
available for mailmerge once the query is “run”. 
 

 
Figure 35 

 
 
Once you are happy with the created query Click Save & Close to retain your data mining results.  
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Back on the datamining screen click the Run Query button as in the screen below. 
 

 
Figure 36 

 

Run 
Query 
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The Query screen will appear as follows: it lists up all the records in the database that fulfill the criteria set in the query builder. The 
user can now click on the Microsoft Word button and do a standard letter mail merge requesting or offering information to the clients 
listed. The user can click on the Microsoft Excel button and export the list into a perfectly formatted Excel Spreadsheet for further 
analysis. 
 
 

 
Figure 37 
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If you are on a network you may want to keep all of your particular saved queries in a directory so that they are available to all staff 
members. If you click the Settings button on the Data Mining screen you can agree a network path. 
 
 

 
Figure 38 
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REPORTS 

There are two main reports which can be run from the text Reports menu: 
 
Client Status Report 
Return Status Report 
 
Client Status Report 

The Client StatusReport selection criteria is as per the screen below. Make the relevant selections you require such as give me a list 
of all clients with a status of “Draft Returns Generated”. 

 
Figure 39 

 
The report will then list all clients with this status along with their other information. 
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Return Status Report 

This report can be used as a summary report of which will give you an overview of how many returns you have at each of the 
available status. It can also be used to show more detail by selecting the “ Detailed” option. This will enable you to tailer the report to 
show you the details broken down according to your specified criteria E.G show only the returns associated to a particular staf 
member. 
  

 
Figure 40 
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STAFF  

If you are a firm who already use ether DRIVE or Relate Accounts Production your staff file will automatically appear in Relate 
Corporation Tax Manager, as it is the same database which is being used by all three applications. 
 
If you are not an existing user go to the Staff option on the navigation bar and click on New, the following screen will appear: 
 
 

 
Figure 41 

 
Fill in the relevant information and click OK to save the new staff member. 
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TOOLS 

Settings 
From the Tools menu, choose Settings. The Settings window appears. Select Practice Details tab.  

 

 
Figure 42 

 
Enter the name of the practice. Enter the contact address along with the contact phone numbers, mobile and fax numbers, e-mail and 
web address. This information is used as the contact information for the Revenue when queries arise and also for email responses. 
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Select the Client Codes tab.  

 
Figure 43 

 
Select the Use Automatic Code Generation check box, if you want the client codes to be automatically generated by the system, 
when entering Client Details. Each code may be broken up into several segments.  
 
The client code can be based on six criteria: client name, office, partner, department, manager and a unique number. This unique 
number may be system unique or it may be code unique. 
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Select Tax Details Tab. 

 
Figure 44 

 
The following information is critical for the proper setup of your tax package: 
 
Enter the TAIN Number of the Practice. This is your official TAIN as issued by ROS. 
Enter the ROS Web Server URL here. (The complete CT1 will be posted here automatically at a later release.) 
View Last Year Details – (This will show last year’s figures alongside the current year for comparison on the schedules) 
Path for Saved CT1 Files.  
Use Web Services for CT1 Files Use Offices, Departments  
Hide Closed Clients 
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Change Database 

The Change Database feature allows the user to work with multiple databases and change the database from within the application. 
This is very rarely used and is not a free option.  
 
Changing the Database 

From the Tools menu, choose Change Database option. The Change Database window appears. 
 

 
Figure 45 

 
Enter the following details: 
Select Server - Enter the server name in which the database you want to change to resides. 
Select Database - Select the database you want to change to. 
Click ok to save. 
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Themes 

Themes allow the user to change the appearance of the entire application including menus, buttons, backgrounds etc. The default 
Theme for Corporation Tax is black. Simply select the theme you wish to apply and it will be automatically applied to the application.  

 

 
Figure 46 


